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Acronyms, Abbreviations, and Symbols

ADOT Arizona Department of Transportation

alt text alternative text; language used to describe figures and
other visual elements to low-vision and blind users.

DOT department of transportation; ADOT’s counterpart in
another state

dpi dots perinch

FHWA Federal Highway Administration; joint sponsor with
ADOT on many research studies

GSA General Services Administration

NTIS National Technical Information Service; federal
depository for US research findings

ORCID Open Researcher and Contributor ID

PM project manager; the ADOT contact who oversees a
research study

SPR State Planning and Research

TOC table of contents

TRB Transportation Research Board

TRDP technical report documentation page; the first page in

an ADOT technical report; provides information about
the report to NTIS; required by ADOT for technical
reports; also called Form DOT F 1700.7

URL uniform resource locator
WCAG Web Content Accessibility Guidelines (version 2.1)

Word Microsoft Office Word, or Microsoft Word



Introduction

Sources for Grammar and Style

The Arizona Department of Transportation (ADOT) Research Center provides this style guide for use with
all research project documents. The ADOT Research Center Style Guide uses three primary published
sources for editing standards and decisions. They are:

e The Chicago Manual of Style (17th edition)

e Merriam-Webster’s Collegiate Dictionary (10th edition or later)

e Guide to Graphic and Editorial Standards for the Arizona Department of Transportation

The guidance here and in these sources may not answer all questions that a consultant may have. The

ADOT Research Center encourages consultants to contact the project manager or the technical editor
for clarification prior to submitting a file for review and approval.

The Role of the ADOT Research Center

The Research Center is dedicated to inquiry and innovation at ADOT. ADOT Research Center studies
address a broad range of topics that are of interest to the department and deliver information that can
be applied to improving ADOT processes and products. Studies are managed by Research Center staff
and conducted by consultants from the private sector, public sector, and universities under contract
with ADOT.

The Role of the Consultant

The consultant team includes a project manager (PM), a technical writer, and other key members, each
of whom must be professionally qualified and experienced in their field. The technical writer may be an
employee of the consulting firm or a contractor associated with ADOT; in either case, both the
consultant PM and the technical writer are required to maintain open communication lines with each
other.

The consultant team works together to create deliverables explaining and analyzing the study and its
results, then delivers those deliverables to the Research Center.

While the research contract requires the technical writer to write the final report, it is the responsibility
of the consultant project manager to provide and communicate the information needed for this task by:
e Sharing the scope of work and the approved work plan.

e Composing a key content summary which highlights the most notable information from each tech
memo.

e Defining needs and expectations for the writer.



Discussing the concepts, content, and development of technical memoranda to ensure understanding
of:

o the study’s objectives.

o the work being done to fulfill the contracted tasks in the work plan.

o the concepts associated with the study.

o the direction and adjustments/feedback received from ADOT.

Providing notes and developments from ADOT meetings, emails, and phone calls.

Involving the technical writer at key ADOT meetings.

The technical writer is responsible for:

Asking, at every stage, enough questions to build a thorough understanding of the study, itsprocess,
and its findings.

Assessing and giving clear feedback to the consultant regarding the information provided.
Reviewing the provided key content summary and all tech memos.

Writing the final report.

Using This Style Guide

The guidance in the ADOT Research Center Style Guide is meant to cover most situations related to

research deliverables. If an issue arises that this style guide does not adequately address, reach out to
the ADOT Research Center technical editor.

To quickly find specific guidance in this style guide, use the Find function (Home > Editing > Find, or

Ctrl + F) and type in the keyword(s) to search.



Deliverables
Guidance For All Deliverables

Section 508 Compliance

The ADOT Research Center requires that consultants make technical memoranda and final reports
electronically accessible in compliance with Section 508 of the Rehabilitation Act of 1973, as amended.
Section 508 guidance is embedded into this style guide; while it may not be specifically called out,
adherence to this style guide will ensure compliance with Section 508 criteria.

Resources

For more specific information on creating compliant documents, stay up to date by checking the US
General Services Administration’s (GSA) website at Section508.gov.

Tools

When creating graphics and figures for any deliverable, add alternative text (alt text) for any visually
impaired users. In addition, colorblind users also need specific color contrasts to distinguish between
shades of certain colors. Several free tools are available that can assist with creating Section 508-
compliant content:

e When using text over colored backgrounds, a specific minimum of contrast is required. Use an
accessibility-oriented color-contrast tool to check and adjust colors.

o To meet the highest accessibility standards, ensure each of the contrast criteria passes the “Web
Content Accessibility Guidelines (WCAG) 2.1 results.” This is usually the case when the contrast
ratio is 7.1:1 or more.

e  When a graphic or image (not a photograph) needs several colors, each must contrast with each
other. Online or software-based tools can be used to choose appropriate and accessible colors.
e Visually impaired people often make use of screen readers—tools that will read text aloud. Use the

screen reader of your choice to check your document; ensure clear delivery and no missing text.

e For additional information concerning Section 508 compliance, visit the US GSA website at
Section508.gov.

Table of Contents

Use the default tool in Microsoft Word™ (Word) for the table of contents (TOC) (References > Table of
Contents > Add Table of Contents). Title the TOC “Table of Contents”; it will contain only the first two
levels of headings (i.e., Heading 1 and Heading 2).



Acronyms, Abbreviations, and Symbols

If the document contains more than five acronyms, then it needs an Acronyms section. The list of
acronyms starts on its own page after the TOC, but it is not included in the TOC. List the acronym with its
definition(s) in this section.

Optionally, this section may also list abbreviations and symbols. If this is the case, then title the page
with the content present (e.g., “Acronyms, Abbreviations, and Symbols”).

References

Overview

Whenever quoting, paraphrasing, or referring to information or ideas (that do not fall into the category
of “common knowledge”) from a publication or outside source, credit the source in a bibliographic
reference. Do not cite secondary sources such as encyclopedias.

Do not use the automated reference listing and citation feature in Microsoft Word 2010. It sometimes
produces inaccurate results. Follow the guidance in this style guide and in The Chicago Manual of Style
instead.

The Using Copyrighted Materials section covers the use of copyrighted material.

How to Cite In-Text References

When referring to work by another author or discussing that author’s ideas, credit the author with a
parenthetical citation at the point of reference in the text. Research Center reports use the author-date
system of citation: The reference is given in parentheses in the text and has the surname of the author,
the source’s publication date, and, if following a quote, the page that the reference was taken from.
There is no comma within the parentheses. Refer to The Chicago Manual of Style for more detail.

Examples:
e For asingle author: (Dodd 2002)
e For a pair of authors: (Gagnon and Dodd 2007)

e For three or more authors: (Peshkin et al. 2010)

Formatting the References Page
e The References section follows the main text of the report but precedes any Notes or

Appendix sections.

o The References section must contain every source cited in the text and only those sources. Carefully
check that references are not repeated in different formats.

e Alphabetize reference entries by the primary author’s surname. Refer to The Chicago Manual of Style
for details on which element to use for alphabetizing when there is no primary author.

e List a source only once on the references page, regardless of how many times it is cited in
the document.



e For listings of reference sources, use a modified version of the format given in The Chicago Manual of
Style; use the “References” style from the Styles gallery for the appropriate hanging intent and
spacing, or go to Home > Paragraph > Indents and Spacing to adjust manually.

e Do not list the uniform resource locator (URL) for references unless noting an online-only source; in
that case, include the access date and the URL as plain text. Refer to the Website listing for another
example.

Example:
The Chicago Manual of Style Blog. August 19, 2022. https://www.chicagomanualofstyle.org/
ganda/latest.html.

Structure for Entries
e The first element is the author’s name (surname first, given name, middle initial).

e If there is more than one author, list the secondary authors’ names in natural order (given name first,
surname last).

e Give each author’s name in full rather than using first and middle initials; initials are allowed only
when the original source does not list the full names.

e Retain any suffixes (e.g., “Sr,” “lll"”) that are available from the source material.

For sources with three or more authors, list all authors by name in the document’s References section,
but use “et al.” following the primary author’s surname for in-text citations. The exception is when two
or more sources have the same author-date citation; refer to The Chicago Manual of Style for treatment
of such cases.

A period separates the author’s name from the date, which is the year of publication only. A period
separates this from the work’s title. If it is a book, it is in italics; if a journal article, it is in quotation
marks. The title uses title case (initial caps on significant words). Refer to the Punctuation and Quotation
Marks and Titles in Italics Versus Quotation Marks sections for further guidance.

A book’s title is followed by the series or report number (if it is part of a series); then the place of
publication followed by a colon; and then the publisher.

Journal article titles are followed by the journal name in italics and title case, the volume number and, in
parentheses, the issue number, a colon, then the page range of the entire article — use an en dash,
without spaces, to separate the first and last page numbers.

Example:
Last-name, First-name, and First-name Last-name. May 2030. “Article Title.” Journal Name
Volume(lssue): 1-15.



When the publisher’s name includes the state name, omit the state abbreviation from the place of
publication. When the state abbreviation is needed, use the two-letter postal code.

Examples:
e Phoenix: Arizona Department of Transportation.
e Thousand Oaks, CA: Sage Publishing.
When citing a source like the Federal Highway Administration (FHWA), use the acronym when citing

within the text (FHWA 2008). When listing the source in the References section, spell out the name
followed by the acronym in parentheses.

Example:
Federal Highway Administration (FHWA). 2008. “Travel Demand Management.”

Unpublished Works

Do not include unpublished works in the references. Cite them in the text with the author’s name, a
description of the author, and the date of authorship in parentheses.

Example:
(Joe Jones, ADOT engineer, unpublished data, March 12, 2002).

Unpublished Interviews

Do not include unpublished interviews (or other personal communications) in the references. Cite them
in the text with the contact’s working title, work unit, and agency name, and in parentheses give the
type and date of communication. Do not use personal names.

Example:
An urban planner from FHWA’s Arizona Division confirmed several reasons for the choice
(telephone interview, March 12, 2002).

Cross Check

Make sure that each reference matches its citation/s in the text. Make sure that the document’s
References section only cites works that are included in the text.

Reference Listing Examples

The following source listings demonstrate examples of recommended styles. (Some examples come
from the Transportation Research Board’s (TRB’s) Information for Authors or from The Chicago Manual
of Style.)

Note punctuation and use of initials and italics. Also note that the formatting for ADOT research final
reports uses the FHWA report number listed on the report’s Technical Report Documentation Page
(TRDP).



Book
Newland, D. E. 1988. Random Vibrations: Spectral and Wavelet Analysis.
New York: John Wiley and Sons, Inc.

Chapter or Section in a Book
McGee, A. M. 2003. “Graduated Driver Licensing.” In Injury Prevention, J. R.
Millman (ed.). Chapel Hill: University of North Carolina Press.

Article in a Periodical
Figueroa, Carlos F., and Amy Nagel. 2017. “Breaking Down Project
Complexities.” Public Roads 81(2):10-13.

TRB Publication
Dewan, Shameem A., and Roger E. Smith. 2003. “Creating Asset
Management Reports from a LocalAgency Pavement Management
System.” Transportation Research Record: Journal of the Transportation
Research Board 1853: 13-20.

Government Report

Von Quintus, H. L., and A. L. Simpson. 2002. Documentation of the
Backcalculation of Layer Parameters for LTPP Test Sections. Publication
FHWA-RD-01-113. Washington, D.C.: FederalHighway Administration.

Seekins, Tom, Alan Blatt, and Marie Flanigan. 2013. Automatic Crash
Notification Project: Assessing Montana’s Motor Vehicle Crash and
Related Injury Data Infrastructure. FHWA/MT-13-005/6608. Helena:
Montana Department of Transportation, Research Programs.

ADOT Research Center Report
Dodd, Norris L., Jeffrey W. Gagnon, Susan Boe, Amanda Manzo, and
Raymond E. Schweinsburg. 2007. Evaluation of Measures to Minimize
Wildlife-Vehicle Collisions and Maintain Wildlife Permeability Across
Highways: Arizona Route 260. FHWA-AZ-07-540. Phoenix: Arizona
Department of Transportation.

Website
Caulfield, Jack. April 24, 2020. A Step-by-Step Guide to the Writing Process.
Scribbr. https://www.scribbr.com/-academic-writing/-writing-process/.



Permission to Use Published Materials

Using Copyrighted Materials

Do not use copyrighted figures (including photographs and diagrams) and tables unless written
permission of the copyright owner is obtained and provided to the Research Center. Prior use of
copyrighted figures and tables in another publication does not necessarily constitute permission to use
it in a specific Research Center publication. Citing the source of figures and tables is not a sufficient
substitute for permission. Materials produced by public-sector agencies (i.e., published by an agency for
public use) do not require permissions.

When conducting the research study, consultants must secure the appropriate copyright releases and
include the release statement in the text; the consultant is legally liable to ensure this is done correctly.
Usage fees are also the responsibility of the consultant. Include the original copy of copyright
permissions with the draft file submitted to the ADOT Research Center to maintain in ADOT records.

For overall copyright explanations and resources, refer to the US Copyright Office website
(http://www.copyright.gov/).

Using Materials That Are Not Copyrighted

Figures and tables that have been previously published or presented, but that are not copyrighted, may
be excerpted on a small scale without permission but must include proper citation. The Research Center
reserves the right to determine when it is necessary to obtain permission.

Include the original copy of copyright permissions with the draft file submitted to the Research Center
to maintain in ADOT records.

Maps

Consultants frequently submit maps created using Google Maps™. Google Maps encourages use of their
maps in publications as long as their embedded attribution is not obscured. Please follow the online
guidance that Google gives for crediting their maps and data providers. For specific usage allowed by
Google, refer to Google Products Guidelines (https://about.google/brand-resource-center/products-
and-services/geo-guidelines/%23google-maps-google-earth-and-street-view).

For correct attribution according to Google, refer to Google Attributions Guide
(https://www.google.com/permissions/geoguidelines/attr-guide/).

The Research Center requires repeating the map image’s embedded attribution and placing it after the
figure’s caption. The text of the attribution must say the name of the map’s source. Place the attribution
immediately following the figure caption in Calibri 9-point font, with 0-point before and 0-point after
spacing between. If a copyrighted map is altered, a note must follow the figure’s caption stating that the
original map has been changed, including how it has been changed and by whom.



Releasing ADOT Study Information

Consultants who conduct research for ADOT must request and receive written permission from the
Research Center before releasing any information associated with the study. “Release” means an action
such as publishing, presenting at a conference, discussing with the news media, or posting on a website.

Study information includes any data and technical findings resulting from the research study, in addition
to published final reports, technical memoranda, or any other documents resulting from the study.

Appendices

Files that were compiled during a study task may be useful to practitioners and other researchers. Place
this information at the end of the report in an appendix or appendices.

When adding an appendix, if there is only one, title it as “Appendix.” If there are two or more
appendices, then designate each appendix with a serial letter (i.e., Appendix A, Appendix B, etc.). If an
appendix also has references cited in its text—for text, figures, equations, etc.—then include a reference
section with it. However, do not use special page numbering; instead, continue numbering pages from
the main body of the document through all appendices.

Begin each appendix on a new page (use a page break). Use the first-level heading style (from the Styles
Gallery) at the top of the page for each appendix. The information within the appendix should follow the
heading; format the data as necessary.

Technical Memoranda

Content

Technical memoranda, or tech memos, fully document major tasks and subtasks as outlined in the
research study’s approved work plan. The content is often highly technical and intended for an audience
of subject matter experts. The content must always be accurate, complete, and clear.

Always write clearly and professionally. Eliminate jargon or buzzwords. If industry terms are
appropriate, make sure that their meaning is clear and define it on the first use, if necessary. Convert
field shorthand and colloquialisms to polished plain speaking. Use generic, third-person references like
“the team” rather than personal names or first-person references. Do not refer to ADOT’s internal
processes, so refrain from mentioning procurement documents, technical advisory committee
directives, PM decisions, or other internal workings of a study.

Tech memos are not necessarily long, but will thoroughly document the following for each task:

e Statement of the purpose or objectives of the task.
e Description of the method/s used.

e Presentation of findings.



e Figures and tables that may add clarification.
e In-text citations with reference list.

e Other elements specified in the work plan, including appendices providing technical data or other
essential details.

Developing Recommendations

Unless ADOT directs otherwise, each research consultant will develop recommendations based on their
findings. Recommendations are fully documented in a tech memo that is delivered prior to the
submission of the final report. The final report then summarizes these recommendations.

The development and presentation of recommendations will vary depending on the research
consultant, the research topic, and the stated objectives. Research results are not predetermined, so
developing a recommendation and how to document it cannot be prescribed. However, there are
general guidelines to observe:

e Use unambiguous language to ensure that recommendations are readily comprehended.

e Use objective language. Do not use language like “ADOT should perform...” or “ADOT must do...”;
rather, explain what certain actions are, how those actions would make an impact, and what things
will be impacted (e.g., “According to the timing data, an increase of a ‘yellow light’ signal from 1.5 sec
to 2 sec may decrease the rate of collisions at this intersection by 15 percent”). State the
recommendations as a set of options for consideration, rather than as directives.

e Reiterate findings and methods only if needed for clarity. Never introduce findings in the
Recommendations section. Findings that are necessary to support a recommendation are
documented separately in the tech memo.

e Ensure that each recommendation is distinct. Avoid redundancy.
e Present practice-ready information rather than theoretical or academic concepts.
e If more research is recommended, be specific as to why and what objectives it would achieve.

e When appropriate, organize recommendations in sequence, such as according to length of time
required, level of priority or difficulty, or extent of resources expended.

e Summarize as much as possible without losing essential information.

e Use bullet lists for organizing thoughts succinctly and coherently. Remember to use parallel
construction so that all bullet items are grammatically consistent.

e Recommendations may be structured based on priorities, resources, or other types of tiers. This is
where a bulleted list may be helpful.

e Since ADOT organizational unit titles might change, refer to work units by their distinct function
(“environmental planning” or “traffic safety”) rather than a formal name (“Multimodal
Planning Division”).

e Endeavor not to place references in the Recommendations section; instead, refer to the relevant
and/or pertinent data as listed in the Findings section.
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e Recommendations must not introduce new material that was not first documented in the tech
memos.

e Summarize the anticipated steps that would be necessary for implementing the recommendations.

Key Content Summaries

The consultant will deliver a key content summary after the finalization of each tech memo in a study. It
will contain approximately 500-2000 words and will convey key information from the technical memo
that is considered appropriate for inclusion in the final report. The key content summary will be written
by the technical writer in consultation with the consultant PM. The ADOT PM will provide the consultant
with guidance on content and format relevant to the specific study.

Final Reports

Overview

Each study requires a final report. The consultant will submit a draft final report written by a technical
writer. The draft final report is a clear narrative that focuses on both recommendations and findings that
will aid in potential implementation. The report will be written for non-academic practitioners—the
language must be accessible to those who are not subject matter experts. The report is not a
compendium of the tech memos, but it summarizes the study’s key points as documented in the key
content summaries that are derived from the tech memos.

Final reports are generally 10,000 to 15,000 words. Count each figure and table as 250 words. Do not
include appendices in the total word count.

The consultant PM will submit the final report with only basic formatting applied. After editing, the
technical writer will place the report into the ADOT Research Center’s formal final report template.

The draft final report will contain the following sections, in this order:

Introduction of the study’s background and objectives.
Recommendations, including, when called for in the study’s work plan, an implementation plan.

Findings, including key data relevant to the Recommendations section.

1
2
3
4. Methods, a summary of methods and tools used to conduct the research.
5. References listing the sources cited in the final report.

6

Appendices, if needed, to further explain or document tables or data.

No other sections, including Acknowledgments, are allowed.

11



Title Page

For the final report, use the front matter template distributed by the ADOT PM and submit a simple title
page that states the study title in full, the study’s State Planning and Research (SPR) number, and the
name, firm affiliation, and address of each contributing consultant. List individual names in descending
order of contribution, with the primary contributor first.

Note that Open Researcher and Contributor IDs (ORCIDs) must be obtained for all contributors by
registering at the “Register for Your ORCID ID” website (https://orcid.org/register). List ORCIDs on
the TRDP.

Technical Report Documentation Page

Requirement

The report’s primary author must complete the TRDP (also denoted as Form DOT F 1700.7) for the
National Technical Information Service (NTIS).

The final report template, provided by the Research Center PM, contains the TRDP template. The TRDP
is also available below.

Font Size

Use 10-point Calibri font for all entries in the TRDP.

Refer to Figure 1 for a sample TRDP. Use the following instructions for filling out the TRDP. The
consultant completes only seven boxes:

Box 4, Title and Subtitle
Enter the entire report title, in title case (initial capital letter on significant words); precede
subtitles with a colon.

Box 7, Author/s

For all authors: In this order, list the first name, middle initial (if the author uses it), and then the
last name. First names must be given; a first initial is not acceptable. List the primary author first.
Enter the names of the individuals, not the agency or firm. ORCIDs must be obtained and shown

with the full names:

“Andrew Robertson, https://orcid.org/1234-5678-9101-1121.”

Place each author on a separate line.

Box 9, Performing Organization Name and Address
Enter the name and address of the organization that employs the consultant (followed by
subcontractor organizations, if applicable).

12



Box 12, Sponsoring Agency Name and Address
Enter:

Arizona Department of Transportation
206 S. 17th Ave.
Phoenix, AZ 85007

Box 15, Supplementary Notes
Enter “Project performed in cooperation with the Federal Highway Administration.”

Box 16, Abstract

Include a 200-250-word summary of the most significant information in the report. The abstract
must fit in the box provided in the template. Briefly mention key findings. The technical writer will
write the abstract as part of the final report file. Define acronyms when they are first used (if used
more than once).

Box 17, Key Words

Enter terms or short phrases that identify the important topics in the report; use title case.
Whenever possible, choose terms from the TRB’s Transportation Research Thesaurus
(http://trt.trb.org/trt.asp).

13



TRDP Content

1. Report No. 2. Government Accession No. 3. Recipient’s Catalog No.
SPR 000-#(###) #H# none none
4. Title and Subtitle 5. Report Date

6. Performing Organization Code

none
7. Authors 8. Performing Organization Report No.
none
9. Performing Organization Name and Address 10. Work Unit No.
none

11. Contract or Grant No.

12. Sponsoring Agency Name and Address 13. Type of Report & Period Covered
Arizona Department of Transportation Final
206 S. 17th Avenue
Phoenix, AZ 85007 14. Sponsoring Agency Code
none

15. Supplementary Notes
Prepared in cooperation with the U.S. Department of Transportation, Federal Highway Administration

16. Abstract

17. Key Words 18. Distribution Statement 23. Registrant’s
Document is available to the U.S. Seal

public through the National Technical
Information Service, Springfield,
Virginia 22161

19. Security Classification 20. Security Classification 21. No. of Pages | 22. Price
Unclassified Unclassified none

Figure 1. Sample Technical Report Documentation Page (TRDP)
Note: This sample TRDP may be copied and pasted into a final report’s document file if any problems arise with the TRDP
included in the final report template.

Report Sections

The final report format no longer uses chapter divisions, and instead is divided into sections:
Introduction, Recommendations, Findings, Methods, References, and Appendices (optional).

While appendices generally better serve tech memos, if a final report requires them, then they will be
placed as the last section, after the References section. Appendices do not count toward the total word
count of the report.

14



Introduction

The Introduction presents, in brief, the foundational information and context needed to understand the
research. This text may include definitions, key statistics, and historical summary. An effective
introduction conveys the reasons for and objectives of the research, while avoiding step-by-step
discussion of methodology or developments leading to the initiation of the study. Summarize the study’s
scope of work and indicate the type of transportation personnel, by function, who would use the
information (for instance, highway designers and traffic safety engineers).

Recommendations

Most research studies culminate in actionable recommendations for ADOT’s consideration. Final reports
place recommendations front and center immediately following the Introduction section so that there is
no need for the reader to skip to the end of the report.

Findings
e Research findings provide the evidence on which the recommendations were developed. This section
summarizes the findings and presents key data relevant to the Recommendations section.

e Be selective. Not every finding or data point necessarily deserves mention in the final report. What do
practitioners want and need to know? What information is essential to establish confidence in the
provided recommendations? Use bulleted lists, figures, and tables where appropriate.

e This section must not introduce new material that has not been previously documented in the tech
memos.

Methods

This final report section is the shortest. How the research was performed in the study is of prime
importance to the researchers, but less so to the practitioners. Remember that methodology has been
documented in the tech memos, which will also be published online.

e Summarize the research process with minimal detail.

e Focus on steps that led to the key findings and recommendations already presented.

o Use bulleted lists when possible.

References

Because the Research Center accepts only the author-date citation style, this section is the alphabetical
listing of sources for published information cited in the report text. The References section provides
guidance for citations and reference list formatting. Do not use a numeric list of sources. Typically, this
section will be one to two pages long.

Notes (Optional)

Use judiciously. This section provides key supporting data and information—whether qualitative,
quantitative, or narrative—that clarifies the information in the preceding sections. The Notes section is

15



similar to an appendix or appendices, but much briefer. This section is not a random collection of raw
data but is carefully chosen to support and inform specific points made in Recommendations, Findings,
and Methods sections.

The Notes section will not exceed 10 pages; however, it is best to keep notes as brief as possible.

Research Briefs

Purpose

The research brief is a separate, two-page, easy-to-read summary of the research study that focuses on
the primary recommendations for ADOT’s possible implementation. The potential audiences include
practitioners, transportation decision-makers, and also members of the media and the public who are
not technical experts. The research brief needs to hold the attention of the technical practitioners while
also being clear to nontechnical individuals. After giving the context for the purpose of the study, the
research brief will cover the study’s findings, recommendations, and potential implementation by ADOT.

Content

Length
The brief is approximately 500 words.

Text Only

The research brief’s content is only text, which will be submitted as a Word file to the Research Center.
Do not include:

e Footnotes

e Figures

e Tables

e (Citations and reference lists (do not include text that requires a citation)

e Appendices or attachments of any kind

Writing the Brief

The research brief is written after the final report. Read the final report and the study’s tech memos for
key points (“takeaways”). Interview the ADOT PM and any key stakeholders that they recommend. Keep
the writing simple, clear, and short. Organize the content around these four headings:

1. Why We Did It: The reasons ADOT needed the research.

2. What We Learned: The key findings and recommendations.

3. How We Did It: A brief description of the methodology.
4.

How We'll Use It: How the research will improve ADOT processes or products.
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When writing the brief, keep the following points in mind:

e When writing about the recommendations and potential implementation, do not use phrases like
“ADOT should” or “ADOT must.”

e Use terms the public will understand, avoiding jargon and acronyms. The brief uses less technical
terminology than the tech memos and the final report. If certain terms are essential, define them
simply and clearly.

e Keep the tone matter-of-fact and professional, but plainspoken. Avoid an academic tone.
e Use short sentences about 15 to 20 words long.

o Keep paragraphs compact. Separate different ideas into shorter sentences so that the main points
are obvious and easily understood.

e Simplify language by deleting unnecessary prepositions, clichés, and insider jargon.

o Make key points direct and concise. Avoid vague language and overly wordy paragraphs.
o Keep numbers simple and readable by rounding them up.

e Use bullet points or numbered lists to express multiple ideas in a paragraph.

e Do not include the name of the ADOT PM or quote them in the brief. Quote only the key stakeholders
who were interviewed and accurately attribute their quotes.

17



Style
Word Use

Acronymes, First Reference

Spell out what an acronym stands for when it is first used in the main text, and then put the acronym in
parentheses immediately following. Do the same within a final report’s TRDP abstract. Acronyms
defined in the abstract must be defined again on the first use in the report’s body. Do not use an
acronym when the term appears only once in the text (except in special cases, such as when the
acronym is more widely known than the phrase it represents).

Example:
The Federal Highway Administration (FHWA) provides guidance on roadway abbreviations.

Acronyms, Plural

To make a plural of an acronym, add an “s.” Do not use an apostrophe unless the acronym is possessive.

Examples:
e  Plural: Pedestrian hybrid beacons would be called PHBs.

e Possessive: ADOT’s policies are available to the public online.

ADOT

This is the acronym to use when referring to the Arizona Department of Transportation on
second reference.

e Do not use “Arizona DOT.”

e The relevant pronoun when referring to ADOT is “it,” not “they.”

e  When not using the acronym, refer to ADOT as “the department” (lower case) or “the agency.”

e Do not use “department” to refer to work groups within ADOT. Those are divisions, offices, sections,
groups, or units.

e  When “ADOT” is being used to describe specificity, use only “ADOT”; do not make it possessive
(“ADOT’s”) unless referring to something that belongs to the department.

Examples:
e “The ADOT warning signs have been helping to reduce collisions.”

e “ADOT’s main offices are in Phoenix, AZ.”
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Department of Transportation (DOT)

When referring to transportation agencies in general, use the term “department(s) of transportation.”
As with other acronyms, spell it out (in lowercase) when first used, immediately followed by the
acronym in parentheses, and then use the acronym for subsequent usage. If making DOT plural, add the
“s” to the word “department.” When using a relevant pronoun, refer to a single DOT as “it” rather than
“they.”

Do not refer to any work unit within ADOT or other DOTs as a “department.” Instead, use “unit,”
“group,” “division,” etc., as appropriate.

Use of the Word “Data”

ADOT reports use the word “data” as plural and “datum” as singular.
Examples:
e The data indicate a significant trend.
e Researchers analyzed these data using several methods.

e The datum is an outlier and has been excluded from the graph.

States

In written text, spell out the names of states. To abbreviate state names in references, tables, and
figures, use the two-letter postal abbreviation. Do not use conventional abbreviations.

Examples:
e |ntext: Glendale, Arizona
e Inreferences, tables, and figures: New Orleans, LA; Tempe, AZ; Baltimore, MD

e Do not use: San Diego, Calif.; Minneapolis, Minn

Trademarks

Avoid using the names of trademarked products when referencing generic concepts (e.g., do not use
“Excel”! in lieu of “spreadsheet”). However, you may use the trademark to describe the concept (e.g.,
“Excel spreadsheet”). When using trademarked or registered names, place the registered trademark (°)
or trademark (™) symbol after the name only at its first mention in the text. Always capitalize
trademarked or otherwise-registered names; refer to Handling Technology Terms and Capitalization for

further guidance.

Always refer to the manufacturer or producer for proper attribution.

United States, Abbreviating

Spell out “United States” when referring to the country as a noun. Abbreviate (without periods) when

1 Microsoft Excel™
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using as a modifier of some other term.

Exception: According to FHWA standards, use periods when referring to a roadway, like U.S. Route 60
(“U.S. 60” upon second reference).

Examples:
e Spell out: The United States faces an overpopulation of deer.

e Abbreviate: The US standard allows that usage.
Capitalization

Titles, Headings, and Captions

A title is the name given to a written document, or section within that document (at least for ADOT
Research Center purposes). A heading is a short and descriptive title preceding a section within a
document. A caption is text given to an image, figure, chart, or table that helps describe or explain it,
and includes the numbering (“Figures” and “Tables” for ADOT Research Center purposes).

Examples:
e Title: “SPR-761: Evaluating Total Maximum Daily Load Pollutants from ADOTs Storm Sewer
System Discharges” — the title of a final report.

e Heading: “Sampling Procedure, Preservation, and Delivery” — precedes a subsection of the
written text.

e Caption: “Table 4. Analytical Constituents by Watershed” — the caption of a table within a
final report.

Use title case in titles, headings, and captions (i.e., capitalize every word except articles [a, an, the],
conjunctions [and, but, for, or, nor], and prepositions of four letters or less [to, of, in, with, etc.]). When
using hyphenated words, capitalize following the same rule.

Examples:
e Hyphenated: State-of-the-Art Bridge Design; Planning for Medium-Sized Communities.

e lLonger phrase: Travel Predictions and Models Beyond the Year 2000; Damage Observed
Between Mileposts 60 and 65.

References to Sections, Figures, or Tables in Text
When referring in the text to a section, figure, or table, capitalized citations are required.

Examples:
“Refer to Table 9.”

“These findings are discussed in Observations.”

In-text citations benefit from formatting that connects the reference to the object being referenced.
This formatting can be handled automatically when using Word’s built-in captioning tool (References >
Captions > Insert Caption or References > Captions > Cross-reference).
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Names of Roadways

Titles of roadways must be written consistently throughout the document. Upon first reference, spell
out the name (e.g., “Interstate 10” [not “Interstate Highway 10”]). Upon second reference, the
roadways may be written as:

e |10

e |-10W and I-10E (no spaces)

Use “route” when naming roadways other than interstates. On their second and subsequent uses,
roadways and highways, such as state routes and US routes, are formatted as [type of roadway] [space]
[number]; (no hyphens are used):

e State Route 114 (first reference), SR 114 (second reference).

e U.S. Route 281 (first reference), US 281 (second reference). FHWA standards require the use of
periods in “U.S.” when referring to federal highways.

e State Loop 202 (first reference), Loop 202 (second reference).

East, West, North, and South

Capitalize directions with a state, city, or any other geographical region only if it is part of a proper
name. Regions typically accepted as proper names may be capitalized. Simple directional modifiers are
not capitalized when they precede a proper name.

Examples:
North Carolina, West Texas or west Texas, Gulf Coast or gulf coast, Gulf of Mexico, Midwest,
western United States, southern Louisiana

Position Titles

Do not capitalize a person’s position title, such as “project manager” or “director.” Capitalize position
titles only if they come before the name and are official titles, such as President Tyler, Congressman
Smith, or Director Jones.

Examples:
John Smith, research assistant; Tom Smith, director of the center; Director Smith.

Programs or Research Items

Capitalize a program or research item (database, software, etc.) only if it is an official proper name or
title. If it is a generic product type, do not capitalize it.

Examples:
e ADOT districts, intelligent transportation systems (ITS), ground-penetrating radar (GPR)

e  Multimodal Planning Division, the Holbrook District
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“State,” “City,” and “Federal”

”n u

Do not capitalize “state,” “city,” or “federal” unless referring to a specific and official government entity.

Examples:
e The State of Arizona [governmental entirety] employs many workers, and the City of
Phoenix purchases supplies.

e The geographic area covered by the state of Arizona [geographic reference] contains
several cities, and the city of Phoenix is not far from the city of Mesa, Arizona.

e The program receives federal funding.

e The Federal Highway Administration distributes the funds.

District
Do not capitalize the word “district” unless it refers to a specific agency name.

Examples:
e Three ADOT districts use the technique.

o The Prescott District expects to implement it during fiscal year 2012.

Decimals, Not Fractions

Where reasonable, use decimals instead of fractions. Place a zero before the decimal point for
guantities of less than one (e.g., 0.25).

Exception: Industry usage (e.g., references to equipment or tools) may sometimes require the use of
fractions. If using fractions, use a consistent form throughout the report (i.e., either 1/4 or %).

Measurements, Symbols, and Equations

Always spell out “degrees” and “percent” in text. Do not use symbols except in figures and tables.

American Versus Metric Units

Provide measurements using the same measures system that was used to take them. If measurements
are taken using metric units, then the measurements must be followed by their equivalent customary
American units in parentheses. Round metric values to the same number of digits as were in the
American number (e.g., 11 miles converts to 18 km [1.609 km/mi equals 17.699 km, which rounds to
18 km]). Convert mixed American units (feet and inches, pounds and ounces) to the smaller unit before
converting to metric rounding (e.g., 10 feet, 3 inches = 123 inches; 123 inches x 25.4 mm =3124.2 mm;
round to 3124 mm).
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Formatting

The ADOT Research Center requires that consultants make technical memoranda and final reports
electronically accessible in compliance with Section 508 of the Rehabilitation Act of 1973, as amended.
Section 508 guidance is embedded into this style guide; while it may not be specifically called out,
adherence to this style guide will ensure compliance with Section 508 criteria.

Formatting refers to the structure and layout of a document’s content.
Page

Margins

One-inch side margins and top margins are required on all pages. Margins for pages with figures and
tables may be slightly smaller if necessary but should not be any less than 0.7 inch on any side.

Columns

Use a single-column, full-page format.

Page Numbering

Page numbers are centered at the bottom of the page. Number the body of the text with Arabic
numerals (1, 2, 3, etc.) beginning with Page 1. Page numbers run consecutively throughout the entire
report, including appendices (i.e., 1, 2, 3, etc.) and are the only thing allowed in the footer space.

If there are more than three pages of front matter in a report (i.e., TRDP, TOC, and acronyms list), then
use lowercase Roman numerals (i.e., i, i, iii, iv, etc.) to number these pages. Do not number the title
page (begin with “ii” on the second page) and use a “Next Page” section break (Layout > Page Setup >
Breaks > Next Page) between the last page of the front matter and the first page of the report’s body—
this ensures separation between page number types and that the report’s body will begin on Page 1.

Headers and Footers

Headers and footers, including footnotes, are not permitted. Consecutive page numbering is the only
thing allowed in the footer space.

Page Breaks

It is sometimes necessary to insert a page break or a “Next Page” section break at the end a page, to
visually assist with clarity, organization, or other purposes. However, do not use either “Even Page
Section Breaks” or “Odd Page Section Breaks,” as these will create unintended gaps in the document.
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Headings

To comply with Section 508, use the styles gallery to implement the following headings. For primary
section headings (e.g., Introduction, Statement of Purpose, etc.), use the first-level heading style,
“Heading 1,” at the top of the page—use a page break if needed. Keep all headings concise and do not
extend beyond the page’s halfway point. Below are the required formats for headings.

FIRST-LEVEL HEADING, FOR PRIMARY SECTIONS.
THIS SECTION ALWAYS GOES AT THE TOP OF A NEW PAGE.

(Calibri 16-point bold, all caps, centered, 0-point before and after spacing)

Second-Level Heading

(Calibri 15-point bold, initial caps, flush left, 12-point before and 0-point after spacing)

Third-Level Heading

(Calibri 14-point italicized, initial caps, flush left, 12-point before and 0-point after spacing)

Fourth-Level Heading

(Calibri 12-point bold, initial caps, flush left, 12-point before and 0-point after spacing)

Fifth-Level Heading

(Calibri 11-point bold, initial caps, 0.31-inch left indent, 9-point before and 0-point after spacing)
These headings generally precede only a single paragraph with 6-point before and 0-point after
spacing, but if more paragraphs are needed they will maintain the 0.31-inch left indent.

Example Heading: (Calibri 11-point, italicized, 0.38-inch left indent, 6-point before and 0-point

after spacing)
Example text is (Calibri 11-point, 0.38-inch left indent, 0-point before and 0-point after spacing)

Widows and Orphans

Do not leave a single line of text alone at the top of a page (widow) or bottom of a page (orphan). You
can access Home > Paragraph > Line and Page Breaks > Pagination and then check mark Widow/
Orphan Control to prevent these.

Do not leave a heading at the bottom of a page without at least two lines of text to accompany it. If
feasible, do not split bulleted lists from their introductory sentences or leave a single bullet alone at the
top or bottom of a page.
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To prevent orphan words (a single word on the last line of a paragraph), use either a nonbreaking space
(or nonbreaking hyphen, if needed) between it and the immediately preceding word, or use a soft
return earlier in the paragraph to even out lines.? This fix is only for visual neatness and should not affect
screen readers. These formatting characters can be found in the special characters box: Insert >

Symbol > More Symbols > Special Characters.

Text

Font

Use Calibri 11-point type for text, including table captions, figure captions, equations, explanatory text
for equations, and text within figures and tables. Figure and table captions should use bold text. Text
within figures and tables may be smaller than 11-point type but not less than 8-point.

Spacing
Use line spacing of 1.15 (Multiple).

Paragraphs

Use the “Text” style to format body paragraphs. Separate headings and subheadings from text by
starting a new line and applying the relevant style (e.g., Heading 1). Do not indent paragraphs.

Justification and Alignment

Set the document to left-align the text (if it is not already). Do not full-justify text.

e Use left justification for text. Do not use full justification.

e Apply orphan control to text to prevent single lines from sitting at the top or bottom of a page. In
Word, this option is found under Home > Paragraph > Line and Page Breaks > Pagination.

e Use single spaces between sentences, not two spaces.

e Insert page breaks when content needs to be moved to the next page. Do not use multiple hard
returns (i.e., pressing the ‘Enter’ or ‘Return’ key repeatedly) until the end of the current page. Screen
reader technologies may read each return aloud.

e Use Word’s Styles function to format headings. Do not make headings by formatting body text;
rather, select the style to designate the text as a heading for first, second, third, and fourth levels;
refer to the Headings subsection. Mark all headings using the Styles tab (Home > Styles).

The templates available from the Research Center already have the necessary styles
formatted appropriately.

2 Insert a nonbreaking space with Alt+255 or Ctrl+Shift+Space on a Windows machine, or Option+Space on a Mac computer.
Insert a nonbreaking hyphen with Alt+8209 or Ctrl+Shift+Hyphen, or Command+Shift+Hyphen on Mac computer.
Insert a soft return with Shift+Enter, or Shift+Return on a Mac computer.
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e Do not underline text.

e Do notinsert hyperlinks (“clickable” URLs).

Figures and Tables

Figures and tables must be clear and legible. Labels within figures and text within tables must use a
clear, legible sans serif font; Calibri is preferred. Hand-drawn or hand-written graphics (or scanned
images of hand-drawn graphics) are not acceptable.

All figures and tables must be referred to in sequential order within the text. Figures must appear close
to the first reference in the text (generally following immediately after the paragraph of that reference),
but not occurring before that reference. Place figures so that they do not break text that belongs
together (e.g., do not break a paragraph) but so they can be seen while reading the text (i.e., on the
same page or facing page).

Quality
e C(Clear, dark, original line art and photographs of sufficient resolution are acceptable. Shaded areas
must not obscure text, parts of figures, or table content.

e Provide photographs with clear resolution in electronic form (300—600 dots per inch [dpi]; .png files
are preferred for their lossless compression).

e Use consistent formatting for similar tables throughout the document. Label table rows and columns
descriptively so that the reader can understand the information at a glance.

Font Size

Text within figures and tables must be no smaller than Calibri 8 point. Use Calibri in a consistent size for
similar tables and graphics throughout the report. If a photo includes text that is meant to be read, the
image must be enlarged enough that the text matches at least Calibri 8 point.

Cite Sources

Document the proper attribution for any figures or tables taken from another source, whether copied
verbatim or just adapted.

Refer to References to Sections, Figures, or Tables in Text for information on how to cite sources and on
the use of copyrighted materials. Give complete sources if the data shown in a figure or table was not
independently collected but was taken from another source.

Numbering Figures and Tables

Number figures and tables consecutively (e.g., Figure 1, Figure 2, Table 1, Table 2) in the report, and do
so consistently through the Notes section. Figures and tables in appendices are numbered consecutively
for each appendix: Figure A-1 or Table B-2.
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Captions

A title is the text used to describe an object in a text document, such as “Incidents Per Year” to describe
a graph or “Convention Attendees” to describe a photograph of several people.

A caption is the title of an object and the accompanying numbering and formatting used for organization
and cross-referencing; for example, “Figure 3. Incidents Per Year” or “Figure 11. Convention Attendees.”
Caption is often used in the place of title in technical documents because it then includes all information
relevant to each object and avoids confusion with any report or section titles.

Modern word processors offer automatic captioning to number figures and tables easily. This formatting
allows for the simple cross-referencing of figures and tables, as well as the automatic numbering
updates when one figure or table is removed and/or another added (Ctrl+A [or “Select All”] > F9).

Table captions should be centered and placed on the line above the table. Place a period after the
caption number. Use the “Table Caption” style: Calibri 11-point bold, 6-point before and 0-point after
spacing on the caption text.

Example:

Table 1. This Is an Example of a Table Caption

Figure captions should also be centered but are placed on the line below the figure. Place a period after
the figure number. Use the “Figure Caption” style: Calibri 11-point bold, centered, 0-point before and
6-point after spacing on the caption text; the figure itself should be centered and have 6-point before
and 0-point after spacing.

Example:

Figure 2. The Golden Gate Bridge

Graphs and charts are treated as figures, not tables. They must have clearly labeled axes set in a clear,
legible font, like Calibri, at a point-size large enough to be easily read (8-point or larger).
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Figures:

Figures must appear close to the first reference in the text, but not before. If the figure’s background

visually blends into the page (e.g., a white outline around the figure closely matches the white of the

document or paper), place a black 0.5-point- or 0.75-point line weight border around it. Be consistent
with all figures in the report.

Photographs and other graphics are to be presented as one image per figure. A pair of photographs is
acceptable as a single figure only when representing a before—and—after scenario. Do not group three or
more photographs/images into a mosaic that requires directional captions (i.e., “clockwise from left”).

e Limit a figure to a single element, whether a graph, chart, or photograph; do not combine multiple
elements like graphs or photographs; do not use sets or collages of photographs. Each element must
be a single-numbered figure with its dedicated caption (figure number and title).

e Place a figure immediately following the paragraph that first refers to it. Make sure that the
paragraph discussing the relevant information also refers to the figure.

e Write captions clearly and completely. Insert caption and cross-reference formatting from the
References > Captions tab.

e Insert figures as .png files. Do not insert images into text boxes nor use them as image anchors.

e Save image items (those that will be inserted into the report) with a minimum resolution of 300 dpi.
Do not save any items by dimension (e.g., 300 pixels by 400 pixels, 2 inches by 5 inches); all figures
can be resized within the word processor after they are inserted.

Charts:

e Separate, or “break out,” certain pieces of pie charts to emphasize or distinguish specific data.
e Keep figures as simple as possible.

e Label each axis clearly and informatively. State the units.

Tables:

Tables should be created within the word processor, not imported from another program. The PM and
other Research Center staff may need to edit the tables. Do not convert a table into a Word object that
cannot then be edited.

Columns of numerals entered in tables should be right-aligned in the data cells and vertically aligned at
the decimal points; refer to the Figures and Tables section of this style guide, as well as the report
templates, for further text-alignment guidance.

o  Write table captions (table number and title) clearly and completely.

e Build simple tables within the word processor. Do not use nested or otherwise complex tables.

e Do not allow rows to break across pages.

e Do not merge cells.
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e Designate the header row and/or header column of tables in Table Properties. This can be
accomplished with the ‘Repeat Header Rows’ formatting (Table Design > Layout).

e Table headers are usually centered.

e  Write column and row headings briefly and clearly. Keep explanations out of the table and in the text.

e If atable cell contains no data, note that in the cell. Depending on the rest of the data, this can be
done with a pair of hyphens or the abbreviation “N/A.” Do not leave cells empty; only when a cell is
intentionally left blank can a single space or other invisible formatting character be used (this does
not mean using white text; rather, a nonbreaking space works well).

e Place a table immediately following the paragraph that first refers to it. Make sure that the paragraph

discussing the table’s data also refers to the table.

e If, and only if, a complex (nested) table is essential, you may save an image of the table as a .png file,
then insert it as a figure. Use alt text to convey the information in each cell — write the alt text
exactly as it should be pronounced.

For text within the cells of the table, use the “Table Heading,” “Table Text,” and “Table Numbers” styles.

In all cases, the table’s text will need enough before- and after-spacing to separate the text from the
tables’ borders; 3-point before and 3-point after spacing is generally effective. For text that will take up
more than a single line within a cell, 1.15 multiple-line paragraph spacing—the same as the report’s
body text—should prove sufficient.

Examples:

Table 2. Table Text Should Be Left Aligned

Header Header Header Header
Header Text Data Text Data Text Data Text Data
Header Text Data Text Data Text Data Text Data

Table 3. Table Number Data Should Be Right Aligned

Header Header Header Header
Header Number Data Number Data Number Data Number Data
0.0 0.2 0.4 0.6
Header Number Data Number Data Number Data Number Data
0.1 0.3 0.5 0.7

Continuation of a Table

When possible, design the table to fit on one page. For a final report, tables may not extend beyond one

page. The final report does not focus on quantified data — if that type of information is necessary, then
it should go in the appendix. Do not break a table at the bottom of a page. Instead, insert a page break
before the table (the extra white space is allowable) and start the table at the top of the next page.
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When a table continues for two or more pages in an appendix or tech memo, apply the “Repeat Header
Rows” option on the Table Formatting tab (select table, then [Table] Layout > Data). It is also acceptable
to create separate tables for each page.

Units

In tables, specify the units used. State the repeated units of measure or degree in the column headings.
Do not repeat these units in the columns. Use the same measurement system that was used in
collecting the data. If data are given in metric units, then give conversions at the bottom of the table.

Number Alignment in Tables

Columns of numbers listed in tables must align at the decimal point (or assumed decimal point). Do not
center the numbers within the column; use right-alignment and a consistent number of digits before or
after the decimal (e.g., one digit before and three digits after the decimal, like “0.123").

Example:
e 100.01
. 50.56
. 8.06

Alternative Text

Resources for writing alt text include the following Social Security Administration’s Alternative Text
Guide (https://www.ssa.gov/accessibility/files/SSA_Alternative_Text_Guide.pdf) and the University of
Washington’s DO-IT article “What Constitutes Good Alt Text” (https://www.washington.edu/doit/what-
constitutes-good-alt-text).

Not all users can see images, graphs, equations, and tables. Instead, they must use assistive technology
to read aloud a preset description. This description is called alternative text, or alt text. Word processors
provide fields for inserting alt text. Complete alt text for figures, equations, and formulas; alt text for
tables may be helpful, but the writer will confirm that it does not simply repeat the table’s caption.

e Complete the title field that is above the alt text description field, when prompted and/or available. If
the title is empty, the screen reader may not recognize the alt text.

e Write a clear explanatory description with as few words as possible. Two to three brief sentences
should be enough to convey the necessary information; consider that it is better to place as much
information as possible into the text of the report and therefore allow the alt text to be perfunctory.

e Do not use unnecessary words. For example, you might write, “This graph’s axes show...,” but do not
say “This is an image of...” or “This is a graph of....”

e Write alt text that specifically explains the pertinent features of the images, graphs, equations, and
tables, but that does not merely repeat text from the report. Do not rely on any automatically
generated alt text.
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e |f a photo contains text that is meant to be read, repeat that text either in the document’s text or in
the image’s alt text.

e  When providing alt text for a table, the alt text must repeat the data in a cell verbatim to how the

data would be spoken aloud.

Example:
If a data cell contains the number “3.1 mm,” write the alt text as: “three point one millimeters.”

” u

e Alt text must spell out the names of all symbols (e.g., “plus,” “multiplied by,” etc.).
e For equations, be sure to type the alt text exactly as the equation or formula should be pronounced.

o Proofread an equation or formula before converting it to an image file. Some characters used in
mathematics are italicized, so ensure that any italics in your equation are used correctly.

Color

Use colors that will be clearly discernable and legible on the monitor screen and in print. Try to avoid the
use of shades that are too similar and may be mistaken for each other. Adjust the color scheme
accordingly so that all data is clearly represented.

e Use colors that colorblind readers can perceive when charting data in graphs or charts; do not use
red, yellow, or green: the “stoplight” colors.
e Use color shades with enough contrast to be clearly distinguishable from each other.

e Use texture with fill colors or chart with different styles of lines so that colorblind users can read
charted data clearly. Do not limit choices to solid fill colors and solid lines.

Equations and Formulas

For writing formulas and equations in text, refer to the Equations and Formulas® section in the
Communication Reference Guide (https://www.fhwa.dot.gov/publications/research/general/15058/)
published by the FHWA's Turner-Fairbank Highway Research Center.

Further assistance in making equations accessible can be found at Creating Accessible Equations in
Word, from The University of Central Florida (https://cdl.ucf.edu/teach/accessibility/ms-
word/equations/).

Equation Numbering

ADOT guidelines require the consecutive numbering of equations throughout the document
(e.g., Eq. 1, Eq. 2).

3 https://www.fhwa.dot.gov/publications/research/general/15058/005.cfm?#_Toc474772867
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Equation Placement

Place the equation on a separate line, using at least 6-point before and 6-point after spacing to separate
it from the paragraph. Indent or center each equation.

Place the equation’s number in parentheses flush with the right margin on the last line of the equation
elements. The tab markers in Word’s ruler may need to be manually adjusted to accomplish this; Figure
3 shows the icons that mark the left and right tab stops and that can be dragged and dropped into place
with the cursor.

Figure 3. Tab Stop Markers in Word’s Ruler

Example:
a+b=c (Eqg.1explains my hypothesis:

a+b=c (Eq. 1)

Creation of Equations

Create an equation or formula with Word’s built-in tool (Insert > Symbols > Equation). If the equation or
formula requires the use of an external equation builder program to create, then after creation save it
as a .png file, insert into the report as a figure or photo, and use alt text to convey the equation or
formula.

If the report uses mathematical symbols, use the equation editor (Insert > Symbols > Equation) to
ensure their accurate reproduction. This creates a unit that appears during PDF conversion as a graphic,
but still allows revision to the source file as needed.

If embedding mathematical symbols in text as font characters (Insert > Symbols > Symbol), the best
choice is to use the normal text or symbol character set in Word. Do not use other character sets,
because they do not convert reliably to PDF.
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Equation Symbol Identification
Identify symbols after their first use to aid the reader. This identification usually appears in a “where”
list. Stack the symbols and definitions vertically (like a bullet list without the bullets). Also be consistent

when introducing the list (e.g., using a colon or not).

Example:
y=mx+Db (Eq. 2)

where:
y = the y value (ordinate)
x = the x value (abscissa)
m = slope
b = y-intercept
And where:
Insert all equations as .png images in the final document.
Add alternate text to the .png that reads exactly as the equation would be spoken.
Add the numbered equation caption to the right of the equation, right-aligned to the right

margin of the page.

Subscripts and Superscripts
Confirm that subscripts and superscripts have been entered correctly. Microsoft Word and other word

processors have tools to assist (Home > Font):

] Iy Font

Figure 4. Subscript and Superscript Formatting
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Grammar for Research Reports

Internet and Technology Terminology

Handling Technology Terms

Some technical terms have become commonplace and no longer need to be capitalized (e.g., web,
website). Capitalize technical terms that are brand names, trademarks, or copyrights (e.g., Excel,
Google), and, when applicable, use trademark symbols at the first use in text. Brand names that begin
with a lowercase letter (e.g., iPod?, iPad®) always use the lowercase first letter, even at the beginning of
a sentence.

Some terms appear frequently in technical documents. The Research Center recommends the following
usage. Please note spelling and hyphenation for these terms:

e “Screenshot” is one word; “screen capture” is two words.

e “Drop-down menu” uses a hyphen.

e  “Email” does not use a hyphen.

Capitalization
Note the proper capitalization of these terms:

e “Mac”® or “iMac”’; “PC” (vs “personal computer”)

o “Hypertext Transfer Protocol” (HTTP); a transfer protocol; hypertext

o  “Hypertext Transfer Protocol Secure” (HTTPS)

e “Internet Protocol” (IP); the internet; an intranet

e “Open Source Initiative” (the corporation); open-source platforms (note the hyphenation)

o “World Wide Web Consortium”; the World Wide Web; the web; a website; a web page

Capitalize the basic alphabet keys, as well as all named keys.

Examples:
o A
e B
e 5

e Return/Enter

Menu items and icon names are usually spelled and capitalized as they appear in their particular
application; if there is direction to press keys or click buttons/menus, the button should be bold.

4 Apple iPod® mobile digital device
5 Apple iPad® mobile digital device
6 Apple Mac® computer
7 Apple iMac® computer
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Example:
Click Home, then select Fonts.

Use full-capital acronyms when referring to file formats. Use the lowercase acronym when it follows a
period and indicates a file extension.

Examples:
e The PNG format is preferred for images with transparencies.

e Please upload as a .png file.

URLs

Web addresses follow the name of the webpage and are placed inside parentheses. Do not hyperlink. If
it is known that a particular web address is no longer valid, make note of that in parentheses following
the URL.

Example:
Paul Revere died in the year 1818 according to the GeoCities page about him
(http://www.geocities.com/Paul-Revere; URL is expired).

Note that this guidance pertains only to a few individual links. This guidance is not to be used for in-text
citations nor as reference-source listings.

In a printed work, if a URL must be broken at the end of a line, the break must be:

e After a colon or a double slash (//).

e Before asingle slash (/), a tilde (~), a period, a comma, a hyphen, an underscore (_), a question mark,
a number sign, or a percent symbol.

e Before or after an equal sign or an ampersand.

Never add a hyphen to a URL to denote a line break, and never allow a hyphen that is part of a URL to
appear at the end of a line.

Example:
http://www.azdot.gov/TPD/ATRC
/Research/emphasis_areas.asp

Punctuation

Bulleted Lists

When a document lists complex material, it is helpful to pull the list out of the paragraph and separate it
with bullets () for better readability. Use bullets for any listing of three or more items and for listings of
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two items if they are longer than a single line of text. Subbullets should follow the same rules; however,

a single subbullet may be used if it is defining or explaining the previous bullet — refer to the Dashes

section for an example.

Clicking the Bullets icon on the Home tab of Word will apply the desired formatting: the First-Line

Indent (i.e., the vertical line of bullets) will be at 0.25 inches, and the Left Indent (i.e., the vertical line

where the text begins) will be at 0.5 inches; the “List Paragraph” style, found in the Styles Gallery, can

also be used.

Use bulleted lists instead of numbered lists unless the items have a specific order or ranking. When

creating bulleted and numbered lists:

Use a phrase or sentence to introduce the list and end it with a colon (:).

Ensure that the introductory sentence clearly identifies whether all items apply (use “and”) or
whether they stand independently (use “or”). Generally, items in the list will not contain any
conjunction linking one item to another.

Capitalize the first word of each bullet, whether they are phrases or full sentences — even for
subbullet items.

End each bullet with a period (or, rarely, a question mark) if they are full sentences — even for
subbullet items. If the items are only single words or simple phrases, do not end with any form of
punctuation (i.e., periods, etc.).

Use parallel grammatical construction within bulleted lists. For example, begin each item with a verb
or a noun (depending on what is appropriate, given the introductory phrase) or make each item a
complete sentence. Do not mix complete sentences with phrases.

When creating a series of definitions in a bulleted list, bold the word or phrase being defined. A colon
follows that word or phrase, then the definition after that.
Examples:
e Tech Memo: One of the first several deliverables submitted after research has begun.

o Key Content Summary: A brief document outlining the major points of a tech memo;
delivered at the same time as the tech memo.

e Final Report: The culmination of all research done for a study.

e Research Brief: The final deliverable for a study, a two-page explanation of the need for
research, how the research was done, and what was learned.

Commas

Use a serial comma when listing a series (three or more items) within text (i.e., the comma before the
lland”).

Use a comma before and after the name of a state that follows a city (e.g., Flagstaff, Arizona, is the
location of Northern Arizona University).
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e A comma also comes before and after a year that follows a month and day (but there is no comma
between a month and year only).

o “January 10, 2009, is the date of the meeting.”
o “February 2010 will be dedicated to a literature search.”

e Use commas to separate digits into groups of three when the number is greater than four digits.
When a number in running text is four digits, it does not have a comma (e.g., 100,000 and 1000).

e Dollar amounts of four digits or more may use or omit a comma (e.g., $1000 or $1,000).
e When elements within a series contain internal commas, use a semicolon to separate the elements:
o The authors were Smith, Johnson, and Walker. (serial comma)

o The authors were Smith, chairman; Johnson, treasurer; and Walker, secretary.

Commas in Compound Sentences

A true compound sentence contains two full sentences joined by a conjunction. A sentence with
compound elements generally contains one subject and two verb phrases. Use a comma to separate the
parts of a compound sentence, but no comma in a sentence with compound elements.

Examples:
e This report identifies some of the key policy questions, but local officials must determine
answers at the grassroots level. (compound sentence)

e This report identifies some of the key policy questions regarding the study and sheds light
on some of the possible answers. (compound elements)

Dashes

The Chicago Manual of Style outlines three basic uses for dashes and hyphens:
e Use a hyphen to connect words that cannot simply have the space between them removed
(e.g., “afruit-laden basket”).

e Use anen dash to insert a “minus” or “subtraction” symbol or to denote a range. Use a space on
either side of the en dash for subtraction (e.g., XT —Z = W), but no spaces when defining a range
(e.g., 12-24).

e Use em dashes to separate a full aside—a piece of information that enriches or clarifies text, which
can be as simple or as complex as the situation calls for—from the rest of the sentence. Do not place
spaces between the words and the em dash.®

To insert these punctuation marks, click the Insert tab then click the Symbol button. Click More

Symbols..., then select the Special Characters tab. Select the needed dash or hyphen then click Insert.

Hyphens in Modifying Phrases

Place a hyphen between words that serve as a modifying phrase. The purpose of the hyphen is to help

8 An em dash can be inserted using Alt+0151 on a Windows machine, or Shift+Option+Hyphen on a Mac computer.
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clarify for the reader that both words modify the word that follows. In certain constructions, leaving the
hyphen out can prove confusing. However, industry usage overrides this style guide (e.g., portland
cement concrete). Check for consistency in the use of phrases or words repeated within a report.

Examples:
e Figure 1 shows a cross section. The cross-section diameter is 1 inch.
e High-resolution photograph, 12-year period, 5-m span, 5-ft wall or 5-foot wall.
e A crumb-rubber mixture was used to pave the playground. Crumb rubber is used to deaden

the noise of passing trains.

Hyphens in Modifying Phrases that End in “ly”:
If the modifying phrase contains “ly,” do not use a hyphen.

Example:
a thermally induced reaction

Spacing after Sentences

Use only a single space between sentences.

Parentheses and Periods

When parentheses or brackets enclose a stand-alone sentence, the period falls inside the parentheses.
(This sentence is an example.) If the material in the parentheses is part of a sentence, the period falls
outside the parentheses (like this).

When a secondary set of parentheses occurs inside parentheses (as here (i.e., this text)), the interior
parentheses should be changed to brackets [like this].

Example:
The bridge two miles down (the one that crosses Grand Avenue [which is a busy shopping district])
is useful for avoiding highway driving.

Punctuation and Quotation Marks

Commas and periods always go inside quotation marks. Semicolons and colons normally go outside
qguotation marks. Question marks and exclamation points depend on use.

Examples:

e The article, “How to Grow Red Tomatoes,” was replaced by “How to Grow Yellow Onions”;
we finally settled on “How to Encourage Gardening.”

e Did you read “The Tell-Tale Heart”? (The question mark is not part of the title)

e He asked, “Where are you going?” (The question mark is necessary to understanding
the question)
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Titles in Italics Versus Quotation Marks

When referring to documents in text, the titles of long works (e.g., books, journals) are in italics, and the
titles of short works (e.g., chapters, journal articles) are in quotation marks. The titles of works that are
not published (e.g., course titles) are usually set in quotation marks.

e Place the following works in italics: reports, books, manuals, journals, proceedings, newspapers, and
dissertations.

e Place the following works in quotation marks: articles, book chapters or sections, papers, pamphlets,

courses, seminars, classes, and projects.

Spelling

American Versus British Spellings

Use conventional American spelling for Research Center documents.

Table 4. Examples of American/British Spellings:

American Spelling

British Spelling

traveled

travelled

acknowledgment

acknowledgement

judgment judgement
focused focussed
color colour
toward towards
backward backwards
defense defence

naturalization

naturalisation

a historical

an historical

Spell Check

Using a spell check tool is helpful, but it cannot ensure correct spelling. Carefully reread the text for

words that may be spelled correctly but are misused.
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Prefixes

Most prefixes do not require a hyphen in current usage. Add the prefix unless the new word will be
misunderstood. Answers to questions about hyphenation of a particular word can be found in lists of
words under each prefix in a collegiate-level dictionary.

L

Exception: Always use hyphens with “quasi-,” “self-,” and “ex-” (when it means “former”).

Examples:
e Semiopaque, transoceanic, semipermeable

” u n u

e “Recover” or “re-cover,” “recreate” or “re-create,” “resent” or “re-sent” (hyphenation

depends on the meaning)

e Quasi-intellectual, self-discovery, ex-marine

Numbers

When to Spell Out Numbers

The rules prescribed here differ from those in The Chicago Manual of Style and better meet the needs of
technical documents. According to these rules, spelling out numbers and using numerals may be
combined within the same sentence.

Spell out:

e Numbers between one and nine (e.g., eight cars)
e Rankings, or ordinals, of first through ninth (e.g., the ninth car)

e A number that begins a sentence (e.g., Eighty-seven percent of the people surveyed liked the idea)
Use a numeral for:

e Numbers 10 and greater (e.g., 10 trucks)

e Rankings, or ordinals, of 10 and greater (e.g., the 10th truck, 21st century). Do not superscript ordinal
numerals (e.g., 17th rather than 17th)

e Percentages (e.g., 5 percent). The percent symbol (%) may be used when referring to specific
measurements, data, in equations or formulas, and in tables. In the report’s running text, however, it
is best to spell out “percent.”

e Notations with measurements (e.g., 5 m, 2 ft)
¢ Time when used as data (e.g., 5 seconds)

According to these rules, the following examples are correct.

Examples:
e Researchers counted five cars and 10 trucks.

e The data indicated a 15-percent increase in vehicles over the past two years.
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Common Unit Abbreviations

Metric Units

e Hectare ha
e Kilogram kg
e Kilopascal kPa
e liter L

e Meter m
e Millimeter mm
e Newton N

Do not use the prefixes deci- or deca-. Instead, use the appropriate digits (and placeholders) needed
to describe the measurement in the next closest iteration (e.g., write “100 meters” rather than
“10 decameters”).

American Units

e Barrel bbl

e Foot ft

e Gallon gal

e Inch inch or inches (do not abbreviate)
e Mile mi

e QOunce oz

e Pound Ib

e Quart q

e Ton ton

e Yard yd

Numerals with Unit Symbols and Abbreviations
Use numerals with English and metric abbreviations and symbols in text, tables, and figures.

Example:
a width of 12 mm (not 12 millimeters)

Spaces:

Place a space between the numeral and the unit. Leave a space between the degree symbol and the
temperature system abbreviation.

Examples:
e 5Skg
o G5ft
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Periods:

Do not place a period after the measurement abbreviation unless it is at the end of a sentence.

Example:
5 kg (not 5 kg.); but a punctuating period may appear following a metric unit at the end of a
sentence, “The weight is 5 kg.”

Plurals:

“w_n
S

Do not add an to symbols or abbreviations. If measurement units are spelled out rather than

abbreviated, pluralize the word as needed in the context of the sentence.

Examples:
e 10 kg (not 10 kgs)

e 10 kilograms (“The tool weighs 10 kilograms” or “That is a 10-kilogram tool”)

Adjectival Phrase:

When it comes to measurements, use a hyphen between the numeral and the unit abbreviation when in
an adjectival phrase. Refer to the Dashes section for further guidance.

Examples:
e a5-mwall

e ab5-ftfence

Spelling Out vs. Abbreviating Units

Spell out metric or American units when not used with a numeral (i.e., when used as data). Use unit
abbreviations in figures and tables. In text, be consistent in using numerals with abbreviations.

Examples:
e The amount is given in meters.

e The project studied a 5-mile pavement section.

Percent

Write out “percent” in text and use a numeral with it, even for numbers less than 10. In a figure or table,
use the percent sign with no space between (or include percent designation in the column heading).

Examples:
e Theincrease was 5 percent.

e 10% (in a table or figure)
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Slope

Express a slope in nondimensional ratios with the vertical component shown first and the horizontal
component shown second (i.e., “V”:“H”). Use the same units for both (meters to meters, etc.).

Time

If units of time (seconds, hours, etc.) are specific measurements, then use a numeral with them. If they
are more general, then spell out the numbers less than ten (following the same rules of Numbers).

When specifying data and using a numeral, abbreviations (with no periods) may be used for units of
time:

e Second: sec (not s)

e Minute: min

e Hour: hr
o Year:yr
Examples:

e The study ran for two years.

e Researchers examined data at 2-sec intervals.

a.m., p.m.

When referring to a specific time, use a.m. or p.m., lower case and with periods. A space goes between
the time and the use of “a.m.” or “p.m.”

Years

When describing decades, add an “s” (e.g., 1980s). If omitting the “19” or “20,” place an apostrophe
before the year to take its place (e.g., ‘90s).

Temperature

When expressing temperature using a degree symbol, use the degree symbol next to the number and
leave a space between the symbol and the measurement abbreviation (e.g., 10° C).

Symbols

Use the proper symbols to denote functions in equations, text, and illustrations. This includes the
multiplication sign (x) and the minus sign (-).

Verify the accuracy of any symbols used in the document during review.
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Pronouns

Pronoun Use

Pronouns must agree in number and gender with the nouns they reference. Readers need to identify
clearly which noun the pronoun refers to (the antecedent). Usually, that means that the antecedent is
the last subject used before the pronoun.

Remember that pronouns must agree with the singular or plural nature of their antecedents. Singular
groups (ADOT, division, team) require singular pronouns and modifiers (“it” or “this”; not “they,”
“their,” or “these”).

To emphasize the collective nature of a noun, specify the population meant: ADOT officials (plural)
rather than ADOT (singular), the committee members (plural) rather than the committee (singular).

Gender-Neutral Pronoun Use

When text does not specify a gender and usage calls for a singular pronoun, it is acceptable in modern
usage to use “they” or “their.”

When referring to ADOT or another government entity, use “it.”
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